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FDOT Civil 3D Drainage 

Stormwater & Sewer Analysis (SSA) 

Description 

This is a 2-day training course to include: 

• Exporting Pipe Network Data from Civil 3D in a Hydraflow Storm Sewers (STM) format.  

• Network Layout in SSA 

• Displaying a CAD File as a Background  

• Network Layout in SSA 

• Running an Analysis on the Network 

• Displaying Analysis Results 

• Displaying a Profile Plot of a Pipe Run 

• Editing Nodes and Links 

• Exporting a STM File from SSA 

• Importing a STM File in Civil 3D 

• Viewing SSA Produced Values in Civil 3D Network Parts 

• Displaying HGL and EGL in a Profile View in Civil 3D 

Objectives 

The student will have a basic understanding of using Civil 3D Pipe Network Data in SSA workflow. 

Audience 

This course is intended for Drainage Engineers, EIs, CAD Designers. 

Prerequisites 

Participants need to have a basic understanding of AutoCAD and Civil 3D.  Participant is required to complete:  

2018-2019 FDOT Civil 3D Drainage course 

Duration:  

16  Hours    

Professional Credit Hours:   

16  PDHs 

 

Note PDH Credit will only be available with Instructor lead or Computer Based Training (CBT) thru Learning Curve. 
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1 GETTING STARTED  

DESCRIPTION 

This course was developed for FDOT Drainage Designers using AutoCAD Civil 3D 20XX, the FDOT Civil 3D 

20XX State Kit, and Autodesk's Storm and Sanitary Analysis (SSA) software. This course provides a complete 

workflow for taking a AutoCAD Civil 3D Pipe Network into Autodesk's SSA software, analyzing the network 

performance, editing pipes and structures, and returning the revised network to AutoCAD Civil 3D.  This section 

provides some basic information to get started using Autodesk's SSA software. 

OBJECTIVES 

This course will train the user on how to use Autodesk AutoCAD Civil 3D, FDOT Civil 3D 20XX State Kit, and 

Autodesk's SSA software for the purpose of: 

• Exporting Pipe Network Data from Civil 3D in a Hydraflow Storm Sewers (STM) format.  

• Network Layout in SSA 

• Displaying a CAD File as a Background  

• Network Layout in SSA 

• Running an Analysis on the Network 

• Displaying Analysis Results 

• Displaying a Profile Plot of a Pipe Run 

• Editing Nodes and Links 

• Exporting a STM File from SSA 

• Importing a STM File in Civil 3D 

• Viewing SSA Produced Values in Civil 3D Network Parts 

• Displaying HGL and EGL in a Profile View in Civil 3D 

• User Interface Basics 

• Plan View Features 

COURSE SUPPORTING FILES 

The exercises for each module are independent of one another and can be used without having to complete the 

exercises in previous modules. Typically, a dwg file or spf file is provided as the starting data for your exercise. 

All files used in this course should be unzipped to C:\Civil 3D 20XX Projects\. 
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STARTING AUTODESK'S SSA SOFTWARE 

From your desktop double click on the the SSA 20XX shortcut icon. A screen will appear to let you know that 

Autodesk SSA software is loading. 

 

 

Once the Autodesk SSA software has loaded, a screen should display as shown below. 
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USER INTERFACE BASICS 

The Autodesk SSA user interface is shown below. The user interface consists of the components:  Menu Bar, 

Toolbars, Plan View, Data Tree, View Tabs, and Status Bar. 

 

MENU BAR 

 

The menus are grouped by command type: 

• File Commands for opening and saving data files; importing geo-referenced orthophotos; 

importing and exporting AutoCAD drawings, AutoCAD Hydraflow files, LandXML files, GIS 

shape files, EPA SWMM input files, and XPSWMM input files; and for printing. 
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• Edit Commands for editing and copying. 

 

• View   Commands for viewing, configuring Plan View display options and displaying toolbars. 
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• Input  Access to all drainage network element dialog boxes that define the model input data. 

 

• Design  Commands for performing design functions on the network model. 
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• Analysis  Commands for defining analysis parameters and for performing the network model 

analysis. 

 

• Output  Commands for displaying the network model analysis results as graphical plots and reports. 

 

▪ Time Series Plot  Commands for the analysis results time series plot, if this plot is 

being displayed. Otherwise, this menu is not available. 

• Window  Commands for arranging and selecting windows within theapplication workspace. 

 

• Help  Commands for getting help. 
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TOOLBARS 

The software provides numerous toolbars that give you quick access to many commands and features. If you 

forget what a particular toolbar button accomplishes, point the cursor at the toolbar button. After you pause 

over the button, a tooltip will be displayed providing a description of what the button performs. 
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All toolbars are docked underneath the menu bar. To display a toolbar, select the VIEW menu and the 

appropriate toolbar. As shown in the following figure, a check mark will appear displayed adjacent to the 

toolbar to indicate that it is visible 

 

MAP TOOLBAR 

o  Select Element Tool - The SELECT ELEMENT tool is used to select network elements in the Plan 

View. The following can be done with the SELECT ELEMENT  tool: 

✓ Double-clicking a network element will display the appropriate element dialog box with 

the selected element current, allowing you to edit its properties. For example, double-

clicking a junction will display the Junctions dialog box with the selected junction current. 

✓ Network elements (e.g., subbasins, junctions, rain gages, etc.) can be dragged to new 

locations. Select the element and then drag the element to the desired location. To lock the 

elements in place so that they cannot be accidentally moved, select EDIT  LOCK 

COORDINATES and a check mark will show up to signify that the elements (and 

corresponding vertices) are locked in place. 

✓ Network elements can be deleted. Select the element and then press Delete. Note that the 

software will confirm the delete command before it is performed. Note that you can disable 

the delete confirmation check in the Options dialog  

✓ Network elements can be converted to a different type of element. Select the element and 

then right-click. From the displayed context menu, select CONVERT TO. Then, select 

the element type to convert to. Only data that is common to both element types will be 

preserved after the element is converted. 
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o  Edit Vertices Tool - The EDIT VERTICES tool is used to grip edit subbasin, channel, and pipe 

vertex points in the Plan View. To grip edit a network element vertex, the following can be done: 

1. Select the subbasin, channel, or pipe to edit using the SELECT ELEMENT  tool. 

2. Change to Vertex Editing mode by clicking the EDIT VERTICES  tool, selecting EDIT  

EDIT VERTICES, or right-clicking the element and choosing EDIT VERTICES from the 

displayed context menu. 

3. The mouse pointer will change into an arrow tip, and any existing vertices on the selected 

network element will be displayed as small squares. The currently selected vertex will be 

displayed as a filled square. To select a particular vertex, click it. 

4. To add a new vertex, right-click and select ADD VERTEX from the displayed context menu or 

press Insert on the keyboard. 

5. To delete the currently selected vertex, right-click and select DELETE VERTEX from the 

displayed context menu or press Delete from the keyboard. 

6. To move a vertex to another location, select the vertex and drag it to its new location. 

7. While in Vertex Editing mode, you can begin editing the vertices for other network elements 

by clicking an element. To leave Vertex Editing mode, right-click and select QUIT EDITING 

from the displayed context menu or select another tool from the toolbar. 

o  Select Polygon Tool - The SELECT POLYGON tool is used to select a group of elements in the 

Plan View for editing or deleting. The following can be done with the SELECT POLYGON tool: 

1. To select a group of network elements, click the SELECT POLYGON  tool or choose EDIT 

 SELECT POLYGON. 

2. Draw a polygon around the area of interest on the Plan View by clicking for each point of the 

polygon. 

3. Close the polygon selection by either double-clicking or pressing Enter. 

o  Measure Distance Tool - The MEASURE DISTANCE tool is used to measure a distance, such as 

overland flow length or subbasin equivalent width from the Plan View. Measuring a distance can 

be done in the following manner: 

1. Click the MEASURE DISTANCE  tool or choose DESIGN  MEASURE DISTANCE. 

2. On the Plan View, click the mouse to draw a line to be measured. Click to define each vertex 

of the line. 

3. While creating the line, it is not unusual to make a mistake digitizing by clicking at the wrong 

location. 

4. Press the Backspace key to delete the last segment. Alternatively, right-click and select 

DELETE LAST SEGMENT from the displayed context menu. 

5. Press the Esc key to cancel the command. Alternatively, right-click and select CANCEL from 

the displayed context menu. 

6. Double-click or press Enter to complete the line being measured. Alternatively, right-click and 

select DONE from the displayed context menu. The software then displays the length of the 

line. 

Note Pressing Esc while measuring cancels the command. 
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o  Measure Area Tool - The MEASURE AREA tool is used to measure an area, such as soil type 

area or land use area from the Plan View. Measuring an area can be done in the following sequence: 

1. Click the MEASURE AREA  tool or choose DESIGN  MEASURE AREA. 

2. On the Plan View, click the mouse to draw a polygon outline of the area being 

 measured. Click to define each vertex of the polygon. 

3. While creating a polygon boundary, it is not unusual to make a mistake digitizing  by 

clicking at the wrong location. 

4. Press the Backspace key to delete the last segment. Alternatively, right-click and  select 

DELETE LAST SEGMENT from the displayed context menu. 

5. Press the Esc key to cancel the command. Alternatively, right-click and select 

 CANCEL from the displayed context menu. 

6. Double-click or press Enter to complete the polygon being measured. Alternatively, right-click 

and select DONE from the displayed context menu. The  software will automatically close 

the polygon and display the area of the polygon. 

Note Pressing Esc while defining the polygon cancels the command. 

o  Zoom Tool - The ZOOM tool is used to zoom in and out of the viewing area of the Plan View, 

Profile Plot, and Time Series Plot. Zooming can be done with the following sequence: 

✓ With the ZOOM tool, clicking the view zooms the viewing area in around the point by a 

factor of two. Holding down the Shift key while clicking causes the view to zoom out. 

✓ With the ZOOM tool, a rectangle can be dragged around a portion of the viewing area to 

zoom in to that region. 

✓ If your mouse has a scroll wheel, you can scroll the wheel to zoom in and out. This is 

especially handy when you have another tool active and you do not want to switch tools. 

o  Zoom Previous Tool - The ZOOM PREVIOUS tool is used to display the previous view. 

o  Zoom Extents Tool - The ZOOM EXTENTS tool is used to zoom out to the full extents of the Plan 

View, Profile Plot, and Time Series Plot. 

o  Pan Tool - The PAN tool is used to pan the viewing area of the Plan View, Profile Plot, and 

Time Series Plot. Panning can be performed in the following manner: 

✓ With the PAN tool, holding down the left mouse button while dragging moves the viewing 

area. 

✓ If your mouse has a scroll wheel (or a middle button), hold it down and drag to pan the 

viewing area. This is especially handy when you have another tool active and you do not 

want to switch tools. 

o  Lock Coordinates - The LOCK COORDINATES icon is used to lock and unlock the network 

elements from being moved within the Plan View, preventing the accidental movement of elements. 
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PLAN VIEW 

The Plan View, as shown in the following figure, provides a layout view (or top view) of the stormwater or 

wastewater network system. The individual elements that make up the network are displayed. The Plan View 

also allows you to graphically layout the drainage network system. 

 

Key items of the Plan View include: 

• The location of drainage network elements and the distances between them do not have to conform 

to the actual physical scale; they can represent a schematic diagram of the network. 

• Elements can have their properties, such as flooding depth at junction nodes or flow velocity in 

channels and pipes, displayed using different colors. This color coding can be controlled using the 

displayed legend. 

• New network elements can be added directly to the Plan View and existing elements can be selected 

for editing, deleting, and repositioning. 

• Background images, such as geo-referenced TIFF aerial orthophoto images and maps, can be 

displayed as a background for reference. 

• CAD drawing files, such as a street drawing, can be imported and displayed as a background for 

reference. 

• The displayed drainage network can be zoomed into and panned from one position to another. 

• Junction nodes, channels, and pipes can be displayed at different sizes to indicate a particular 

property. Flow directional arrows can be displayed on channels and pipes to indicate the direction 

of flow from the analysis results. 

• Element ID labels and numerical property values can be displayed adjacent to network elements. 

• The Plan View can be printed, copied to the Microsoft Windows clipboard for pasting into a Word 

document, or exported as an Autodesk® AutoCAD® drawing file for report generation. 
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AERIAL VIEW 

The Aerial View, as shown at the bottom of the Navigation Pane as in the following figure, displays the entire 

network and identifies the current view with a rectangular view box. You can use the Aerial View to change 

the view in the Plan View window quickly by dragging the view box. As you drag the view box to another 

location, the display in the Plan View will be redrawn accordingly. 

To display the Aerial View, select VIEW  AERIAL VIEW or click the AERIAL VIEW  icon on the 

standard toolbar. To hide the Aerial View, select VIEW  AERIAL VIEW or click the AERIAL VIEW 

 icon again. 
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DATA TREE 

The Data Tree, as shown below, provides access to all of the data elements contained in a project. Select the 

EXPAND  and COLLAPSE  icons to see the hierarchical representation of the data associated with a 

modeling project. The contents of the data tree vary, depending on what data is defined. 

 

VIEW TABS 

The view tabs at the top of the screen allow you to quickly move from one view to another by clicking the 

tab of your choice. As shown in the following figure, the view tab of the active view has a foreground color, 

tabs for inactive views have a background color. To close a tab, click the  symbol on the tab. The view tabs 

at the top of the screen allow you to quickly move from one view to another. 
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STATUS BAR 

The Status Bar, as shown below, appears at the bottom of the application, and provides information about 

the network model or the task you are working on. 

 

• Run Status  This section of the status bar indicates whether the simulation results are 

available.Three different states can be shown: 

 

✓ No Results  Analysis results are not available. Re-run the simulation to get the results. 

✓ Results Complete  Analysis results available. 

✓ Results Differ  Analysis results are available, but may be invalid because the model data 

has been modified. Re-run the simulation to get the results. 

• Zoom Level  This section of the status bar indicates what the current zoom level is for the Plan 

View. A value of 100% indicates that the Plan View is zoomed to the extent of the model. 

 

• XY Coordinates  This section indicates the current coordinates of the mouse pointer. 

 

• Element Information  As shown in the following figure, this section details information regarding 

the element directly underneath the mouse pointer.  
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PROGRAM OPTIONS 

The program configurations are defined by the Options dialog box, as shown in the following figures. Select 

EDIT  OPTIONS to display the Options dialog box. 

 

 

The Options dialog box controls the program configuration options.  The following configuration settings can 

be specified in the Options dialog box. 

• Confirm Deletions  This check box causes a confirmation dialog box to be displayed before deleting any 

 network element. 

• Automatic Backup File  This check box causes the software to automatically save a backup copy of a 

newly opened project. The default backup file extension is .BCK so as not to overwrite an Autodesk® 

AutoCAD® Civil 3D® or Autodesk® AutoCAD® Map 3D drawing file backup. 

• Automatic Open Last Project on Startup  This check box causes the software to automatically load the 

last saved project upon program startup. 

• “Do not ask again” Messages  These check boxes control whether the Help Tip dialog boxes will be 

displayed. 

• Clear Previous File History List  Clicking Clear causes the list of most recently opened projects to be 

cleared from the File Menu. 
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DISPLAY OPTIONS 

The Plan View display can be modified using the Display Options dialog box, as shown in the following figure.  

To show the Display Options dialog box: 

• Select VIEW  DISPLAY OPTIONS 

• Click the DISPLAY OPTIONS  icon 

• Right-click the Plan View to display the context menu and then select DISPLAY OPTIONS 
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o Elements - The Elements section controls the display of network elements. Select the check box 

adjacent to each element type to control the display of that element type. 

 

o Arrows - The Arrows section controls how element directional and flow arrows are displayed on 

the Plan View. Note that flow arrows will only be displayed after an analysis has been performed, 

and a computed output parameter has been selected for display. Otherwise, element directional 

arrows will point from the starting node to the ending node. 

 

✓ Arrow Size:  This spin control sets the element directional and flow arrow size. 

✓ Display at Zoom:  This spin control defines the minimum zoom ratio at which element 

directional and flow arrows should be displayed. Element directional and flow arrows will 

be hidden at zoom ratios smaller than this. 

✓ Arrow Style:  This radio group defines the shape of element directional and flow arrow to 

display. Select NONE to hide the arrows. 

o Properties - The Properties section defines how subbasins, nodes, and links are color-coded based 

upon the selected input or output property. From the element drop-down list, select the property to 

be displayed as a color-coded attribute. The Plan View then displays the elements similar to the 

following figure.  
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The following element properties are available for selection. Note that element output properties 

(i.e., Total Inflow, etc.) are only available after the analysis has been performed. Select NONE if 

you do not want to have any elements to be colored based upon a property. 

✓ Subbasins View 

 

▪ None 

▪ Basin Area  Drainage area (acres or hectares) 

▪ Basin Slope  (ft/ft or m/m) 

▪ Equivalent Width (ft or m) 

▪ Rainfall Rate  (in/hr or mm/hr) 

▪ Snow Depth  (in or mm) 

▪ Loss Rate  Infiltration + evaporation (in/hr or mm/hr) 

▪ Runoff Flow Rate (cfs or cms) 

▪ Groundwater Flow  Groundwater flow into drainage network (cfs or cms) 

▪ Groundwater Elevation (ft or m) 

✓ Node View 

 

▪ None 

▪ Invert Elevation (ft or m) 

▪ Water Depth  Water depth above node invert (ft or m) 

▪ Water Surface Elevation (ft or m) 

▪ Volume Water volume held in storage (including ponded water, ft3 or m3) 

▪ Lateral Inflow Runoff + all other external inflows (cfs or cms) 

▪ Total Inflow  Lateral inflow + upstream inflows (cfs or cms) 

▪ Flooding Flow Rate Surface flooding (inflows lost from the system 

▪ Exfiltration 

▪ Catchbasin Flow 

▪ Catchbasin Depth 

▪ Catchbasin WSEL 
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✓ Link View 

 

▪ None 

▪ Maximum Depth Maximum water depth (ft or m) 

▪ Roughness 

▪ Slope  (ft/ft or m/m) 

▪ Flow Rate  (cfs or cms) 

▪ Average Depth Average water depth (ft or m) 

▪ Flow Velocity (ft/sec or m/sec) 

▪ Froude Number 

▪ Capacity Ratio Ratio of Depth to Full Depth 

o Symbols - The Symbols section determines which element types are represented with special 

symbols on the Plan View. 

 

✓ Symbols:  If checked, then simple circles will be used. 

✓ Display Node Symbols:  If checked, then special node symbols will be used. Otherwise, 

simple circles will be used. 

✓ Display Link Symbols:  If checked, then special link symbols will be used. 

✓ Display at Zoom:  This spin control defines the minimum zoom ratio at which symbols 

should be displayed. Symbols will be hidden at zoom ratios smaller than this. 

✓ Size:  This radio group allows you to specify the symbol size to use. 
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o Plan View - These options affect the general display options of the Plan View. 

 

✓ Background Color:  The drop-down entry allows you to select the background color for 

the Plan View. 

✓ Blinking Map Highlighter:  This check box controls whether the selected element on the 

Plan View is to blink. 

o Annotation - The Annotation section controls what element IDs and specified values are to be 

displayed on the Plan View. 

 

✓ Rain gage IDs:  If checked, then Rain gage IDs will display. 

✓ Subbasin IDs:  If checked, then Subbasin IDs will display. 

✓ Node IDs:  If checked, then Node IDs will display. 

✓ Link IDs:  If checked, then LinkIDs will display. 

✓ Subbasin values:  If checked, then Subbasin values will display. 

✓ Node values:  If checked, then Node values will display. 

✓ Link values:  If checked, then Link values will display. 

✓ Use Transparent Text:  This check box will display the labels with a transparent 

background. Otherwise, an opaque background will be used. 

✓ Font Size:  This spin control sets the annotation font size. 

✓ Display at Zoom:  This spin control defines the minimum zoom ratio at which labels 

should be displayed. Labels will be hidden at zoom ratios smaller than this. 
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o Nodes - The Nodes section controls how nodes are displayed on the Plan View. 

 

✓ Diameter:  When mapping input data or output results on to the nodes (e.g., invert 

elevation, water depth, total inflow, etc.), this spin control defines the default node diameter 

(or width) in pixels. When not mapping input data or output results on to the nodes, the 

nodes are displayed as their element icon. 

✓ Display Border:  When mapping input data or output results on to the nodes, this check 

box defines if a border should be drawn around each node. This is recommended for light-

colored backgrounds. 

✓ Proportional to Value:  When mapping input data or output results on to the nodes, this 

check box specifies if the node diameter should increase as the viewed parameter increases 

in value. 

✓ Display Flooding:  After the analysis is complete, this check box defines if a flooded node 

should be displayed on the Plan View in the color of blue. The adjacent spin control 

regulates the size of the displayed flooded and surcharged nodes. 

✓ Display Surcharging:  After the analysis is complete, this check box defines if a 

surcharged node (bolted manhole cover) should be displayed on the Plan View in the color 

of red. The adjacent spin control regulates the size of the displayed flooded and surcharged 

nodes. 

o Links - The Links section controls how links are displayed on the Plan View. 

 

✓ Thickness:  When mapping input data or output results on to the links (i.e., diameter, flow 

rate, etc.), this spin control defines the link thickness in pixels. 

✓ Display Border:  When mapping input data or output results on to the links, this check 

box defines if a black border should be drawn around each link. This is recommended for 

light-colored backgrounds 

✓ Proportional to Value:  When mapping input data or output results on to the links, this 

check box specifies if the link thickness should increase as the viewed parameter increases 

in value. 

✓ Display Flooding:  After the analysis is complete, this check box defines if a flooding link 

should be displayed on the Plan View in the color of blue. The adjacent spin control 

regulates the width of the displayed flooded and surcharged links. 

✓ Display Surcharging:  After the analysis is complete, this check box defines if a 

surcharged pipe should be displayed on the Plan View in the color of red. The adjacent 

spin control regulates the width of the displayed flooded and surcharged links. 
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o Subbasins - The Subbasins section controls how subbasin areas are displayed on the Plan View. 

 

✓ Outline Thickness:  This spin control defines the thickness of the line used to draw the 

subbasin boundary. Specify a thickness of zero if no boundary is to be displayed. 

✓ Color:  This color panel allows you to select the color to display the subbasin as. click the 

[...] browse button to display a color selection dialog box, which is used to change the color 

for the subbasins. 

✓ Fill Style:  This radio button group specifies the style used to fill the interior of the subbasin 

area. 

✓ Display Outlet Link:  This check box denotes whether a dashed line is to be drawn 

between the subbasin centroid and the subbasin’s outlet node (or outlet subbasin). 

✓ Labels:  The Labels section controls how labels are displayed on the Plan View. 

✓ Use Transparent Text:  This check box will display the labels with a transparent 

background. Otherwise, an opaque background will be used. 

✓ Flyover Map Labeling:  This check box will cause the element ID label and the value of 

the selected property to be displayed adjacent to the element whenever the mouse is placed 

over an element on the Plan View. 

✓ Display at Zoom:  This spin control defines the minimum zoom ratio at which annotation 

should be displayed. Annotation will be hidden at zoom ratios smaller than this. 

o Legends - The Legends section defines which element property legend should be displayed on the 

Plan View, as shown in the following figure. The legends display colors that are associated with a 

range of values for the element property being viewed. 
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Separate legends exist for subbasins, nodes, and links. If a particular element property is set to 

NONE, then that element’s legend will not be displayed. Also, an option is available for displaying 

the date and clock time of the simulation period being viewed on the map. 

 

To turn off a legend that is displayed in the Plan View, double-click it. To re-display a legend that 

was turned off, right-click the Plan View. The software will display a context menu, which allows 

you to turn on the display of the legend. 

 

To re-display a legend that was turned off, right-click the Plan View and select the legend(s) to turn 

on or off 
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To move a legend to another location on the Plan View, click the legend with the left mouse button 

and drag the legend to its new location and then release the mouse. 

 

To edit a legend, right-click the legend. The software then displays the Legends Options dialog box, 

as shown in the following figure. 

 

The Legend Options dialog box allows you to define a set of numerical ranges to which different 

colors are assigned for viewing a particular parameter for the elements on the Plan View. The 

following options are available: 

✓ Water Depth values, entered in increasing downward order, are used to define the color 

ranges. All four edit fields do not need values specified. 

✓ To change a color, click its color band in the dialog box. The Color dialog box will be 

displayed, allowing you to select a new color. 

✓ Click the Auto Scale button to automatically assign ranges based on the minimum and 

maximum values attained by the parameter being displayed for the current time period. 

✓ Click the Color Ramp button to select from a list of built-in color schemes. 

✓ Click the Reverse Colors button to reverse the ordering of the current selection of colors 

(the color in the lowest range becomes that of the highest range and vice versa). 

✓ Select the FRAMED check box if you want a frame drawn around the legend. 
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INPUT DATA DIALOG BOXES 

Note that the software uses interactive dialog boxes for editing network input data. Double-click an element from 

the Plan View using the SELECT ELEMENT  tool as shown in the following figure. The appropriate element 

dialog box is then displayed. Select the Select Element tool and then double-click a network element to display 

the corresponding element dialog box. 

 

The network element dialog boxes are modeless, allowing you to keep them displayed while selecting other 

elements in the network from the Plan View.  

For example, to examine manhole rim elevations, you can keep the Junctions dialog box displayed and select 

different junctions from the Plan View. Upon selecting a new junction, the software automatically updates the 

input (and output) data regarding the selected element, as shown in the following figure. 

 

In most network element dialog boxes, the network element data is displayed in a table, allowing you to easily 

browse, edit, copy, and paste data. In addition, clicking the column header at the top of the table allows you to 

sort the data in descending (or if clicked twice, ascending) order, as shown in the following figure.  
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For example, using this feature allows you to quickly find “outliers” in the defined element data where there may 

have been a data input blunder. Sorting the column allows you to see if there are any elements with unusual 

values or perhaps a missing value.  

 

Multiple network element dialog boxes can be displayed, if desired. However, the computer monitor may become 

somewhat cluttered with dialog boxes. If you have dual monitors at your computer, you can grab the element 

dialog boxes and drag them to the other monitor allowing you to more effectively edit the network. Once 

completed with the data input for a particular network element, click the Close button. 

RIGHT-CLICK CONTEXT MENU 

To provide you additional ease at using the software, the right-click context menu option is used extensively 

throughout the software. To display the right-click context menu, click using the right mouse button. An example 

of the right-click context menu for the Plan View is shown in the following figure. 

 

  



GETTING STARTED ______________________________________________________________________________ Chapter 1 

FDOT Civil 3D Drainage & SSA  ©2018 FDOT  1-27 

The available options shown on the right-click context menu can change, based upon the context of what you 

are pointing at. For example, when pointing the cursor at a Subbasinl on the Plan View, only those commands 

corresponding to Subbasins are presented in the displayed right-click context menu. Moving the cursor away 

from any network elements, only commands corresponding to the Plan View are presented in the right-click 

context menu. 

 

The right-click context menu is available throughout the software, from the Plan View, Data Tree, Time Series 

Plot, Profile Plot, etc. 
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2 SSA & CIVIL 3D WORKFLOW 
INTRODUCTION 

DESCRIPTION 

This chapter introduces the SSA and Civil 3D Workflows and the steps required to prepare Civil 3D Content for 

use in SSA. 

OBJECTIVES 

In this chapter, you will learn about : In this chapter, you will learn about: 

• Network Layout in SSA 

• FDOT Design Criteria used in this Manual 

• Migration Requirements from Civil 3D to Storm & Sanitary Analysis. 

CHAPTER SETUP 

Run the Chapter 2 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual. 

OVERVIEW OF NETWORK LAYOUT IN SSA 

When laying out a drainage network you have two strategies to choose from. The first, start in SSA with 

Catchment Areas and manually add nodes and links. This approach may be more appropriate when designing a 

schematic network that is not to scale. The second, start in Civil 3D with a Pipe Network then export to the 

Hydraflow Storm Sewers STM format file and import the STM file to SSA. The example in this training guide 

uses the second strategy.  

The workflow is outlined below. 

• Define the default options and element properties to use in the analysis model. 

• Import Pipes and Structures in the STM file from Civil 3D 

• Edit the properties of the elements that make up the system. 

✓ Connect Subbasins to Inlets 

✓ Convert Junctions to Inlets where necessary. Use Civil 3D Migration Settings to . 

• Define the analysis options. 

• Run the analysis. 

• View the analysis results. 

• Adjust the design 

• Rerun the analysis 
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DESIGN CRITERIA FROM THE FDOT DRAINAGE MANUAL 

➢ TOC Minimum is 10 min. 

FDOT Drainage Manual, 3.5.1 Time of Concentration:  Minimum allowable time of concentration is 10 minutes.  

➢ Pipe Slope and Minimum Velocity 

FDOT Drainage Manual, 3.6.1 Pipe Slopes:  Use a physical slope that will produce a velocity of at least 2.5 feet 

per second (fps) and no greater than 15 fps when the storm drain is flowing full.  

For pressure flow storm drain systems, the minimum physical slope is 0.1 percent.  

➢ Pipe Size and Length 

FDOT Drainage Manual, 3.10.1 Pipe Size and Length:  The minimum pipe size for trunk lines and laterals is 18 

inches. The minimum pipe diameter for all proposed exfiltration trench pipes (French drain) is 24 inches.  

The 18-inch minimum pipe size does not apply to connections from external, private stormwater management 

facilities. The pipe size for these connections is the size required to convey the Chapter 14-86, F.A.C. or other 

authoritative permitted discharge limitations.  

➢ Using SSA to Specify Invert Elevations 

SSA Help File:   

• Invert Elevations or Offsets:  The software allows you to work in either elevation or depth mode. Working 

in elevation mode causes all input data to be entered as elevations (e.g., pipe inlet invert elevation). 

Working in depth mode causes some input data to be entered as a depth offset from the element invert 

(e.g., pipe inlet invert offset). Elevation is the default mode. Note that this is controlled by the entry 

ELEVATION TYPE in the Project Options dialog box, General tab. 

• Inflow and Outflow Pipe Invert Elevations:  Backwater surcharging can occur where smaller diameter 

pipes connect to larger diameter pipes and when the pipes have the same invert elevation. This typically 

happens along a main line sewer as the pipe size increases downstream and at connections of tributary 

and main line sewers. To reduce the potential for surcharging and backwatering, the following two options 

are generally used: 

o Crown (top of pipe) elevation of the smaller upstream pipe is matched to the crown elevation of the 

larger downstream pipe 

o Crown elevation of the smaller upstream pipe is above the crown elevation of the larger downstream 

pipe by the amount of loss in the access hole (this practice is often referred to as hanging the pipe 

on the hydraulic gradeline) 

REFERENCE MATERIAL 

• See document(s): GUID-53DEA840-95F1-4727-ACBE-6DACC3B14BBA-htm.html - Moving Pipe 

Network Data Between AutoCAD Civil 3D and Storm Sewers at  https://knowledge.autodesk.com/ 

• Refer to the online Autodesk Help for more details on data migration. 

  

https://knowledge.autodesk.com/support/civil-3d/learn-explore/caas/CloudHelp/cloudhelp/2018/ENU/Civil3D-UserGuide/files/GUID-53DEA840-95F1-4727-ACBE-6DACC3B14BBA-htm.html
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 REQUIREMENTS FOR MIGRATING CIVIL 3D DATA TO SSA 

Subbasins (aka Catchments in Civil 3D), structures, and pipes are collectively referred to as Elements in SSA. 

In this guide we will use terminology used in SSA. As you can see this terminology is sometimes different than 

that used in Civil 3D. 

Catchments, structures, and pipes in Civil 3D must be configured correctly in order for the successful transfer of 

data to SSA.  This section covers what conditions must be met for each Element type in order to transfer data. 

Note Failing to provide any one of these requirements will cause the structure to not export to SSA using the 
Edit in SSA command. Since there are numerous ways to fail using the Edit in SSA command and no error 
trapping to help you find and correct deficiencies we have provided a different workflow that can more 
predictably produce desired results. 

Hydraflow Storm Sewers file format has a STM file extension. We will use this format to transfer data to and 

from SSA. Only the pipe network data (i.e., manhole structures, storm drain inlets, and pipes), subbasin data that 

contributes runoff to junctions and storm drain inlets, and Rational Method Intensity-Duration-Frequency (IDF) 

data is transferred using the STM file format. Time series rainfall data, detention ponds, and other specialty 

hydrology data is not transferred.The SSA Help file provides greater detail on using the Hydraflow Storm Sewers 

file format to transfer data between Civil 3D and SSA. 

When creating the STM file you will need the catchments with the TOC computed from the Flow Path. An 

alternative is to create parcels from polylines and export to LandXML. The downside to Parcels is that they do 

not have any TOC info. Parcels have the benefit of automating labels and creation tables for catchment areas 

which are not a strength of catchments. Calculating TOC and assigning an inlet structure are the benefits to 

creating catchment objects and this method will be used in the exercises in this document. Use the Hydraflow 

STM format for output of Pipe Network structures, pipes, catchments with calculated TOC for use in SSA. 

• Catchments 

o Flow Path Slope must have a non-zero, non-negative value. 

o Time of Concentration must be greater than zero. 

Note If Flow Path Slope is zero, the Time of Concentration is set to zero. 

If you have selected the Time of Concentration Method for the Catchment Properties as TR-55 and did not 
provide the corresponding slopes to the Flow Segments (i.e. slopes for the Sheet Flow, Shallow 
Concentrated Flow and Channel flow segments) as the default value assigned by Civil 3D is zero slope.  

The Flow Path has no Time of Concentration as the slope of the flow line is zero.   A Time of Concentration 
of zero does not export since there is nothing to evaluate.  
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Note Hence, you may want to expand the Catchments from the Prospector tab. Right click the Flow Path and 
select Edit Flow Segments to modify the slopes to a non-zero value. Make sure the Slope is not zero or 
negative. Set the Surface Type to Paved for the examples in this Manual. 

 
 

o  Catchment must have a Structure assigned and set to Inlets in Storm Sewers Migration Defaults. 

 

• Structures 

o Structure must have an outgoing pipe connected. 

• Pipes 

o Pipes without an upstream structure will be assigned a null structure in SSA. The term Line is used 

in SSA to mean a pipe and an upstream structure.  
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Exercise 2.1 Set Civil 3D Storm Sewers Migration Defaults 

Assign structures used in the design as either an inlet or manhole. When imported to SSA you can save some 

work in SSA by having the correct structure type pre-defined in the Part Matchup Settings dialog. 

   

1. Start Civil 3D by double clicking the  shortcut from your desktop. 

2. Open the DRPRRD05.dwg file found in the C:\Civil 3D 20XX Projects\22049555201\Drainage folder 

of the project. 

3. In the Toolspace on the Settings (tab) scroll down to Pipe Network right click and select Edit Feature 

Settings. 

4. Scroll down and expand Storm Sewers Migration Defaults and find Part Matching Defaults. 
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5. In the Edit Feature Settings - Pipe Network dialog expand Storm Sewers Migration Defaults. Edit 

the Part Matching Defaults by picking the ellipsis button to open the Part Matchup Settings dialog. 

 

6. Select the Export tab and expand the Exporting Structures collection. 
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7. Scroll down to the Civil 3D Part Type Index No. 425-020 - Curb Inlet Type 2 with Round Bottom. Click 

the dropdown list in the Storm Sewers Part Type column and select Curb Inlet Horizontal Circular. 

You only need to assign the correct part type to the structures and pipes actually used.  

Note You have a limited part list for the return trip from SSA to Civil 3D so putting effort into assigning multiple 
variations of the same part in your design in Civil 3D at this stage of the workflow is not recommended.   

An outfall structure will be assigned in SSA therefore it has been omitted in the workflow up to this point. 

   

8. Scroll down to the Exporting Pipes collection to verify the Civil 3D Part Type Pipe Culvert S/CD is 

set to Storm Sewers Part Type Circular Pipe. 

Note The Storm Sewers Part Type has a limited selection for Pipes therefore it is not recommended to spend 
time in Civil 3D assigning variations to pipe parts. Those variations will not survive the round trip from Civil 
3D to SSA and back to Civil 3D. The only reason to assign variations is to keep a record of your original 
choices in a backup drawing file so you can manually compare it to the imported pipes from SSA. 

9. Click the Apply button. Click the OK button to close the Part Matchup Settings dialog. 

10. Save the DRPRRD05.dwg 
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Exercise 2.2 Export Pipe Network to a Storm Sewers File (.STM) 

 

 Continue using the DRPRRD05.dwg file from Exercise 2.1.  From the Output tab on the ribbon in the 

Export panel, select the Export to Storm Sewers command to create an STM file. 

 In the C:\Civil 3D 20XX\Projects\22049555201\Drainage  folder create an folder named ssa . 

 Create the file Proposed Drainage - SR61.stm file in the ssa folder: C:\Civil 3D 

20XX\Projects\22049555201\Drainage\ssa\Proposed Drainage - SR61.stm 

 Save and Close the DRPRRD05.dwg, and  then Close Civil 3D. 
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3  SETUP IN SSA 

DESCRIPTION 

When you create a new project in SSA the first step is to configure the Options to fit the project's requirements. 

To do this you will make changes in the Project Options dialog, Analysis Options dialog. 

OBJECTIVES 

In this chapter, you will learn about: 

• SCS TR-55 

• Rain Gauges 

• Rainfall Designer 

• IDF Curve Zones 

• Analysis Options 

CHAPTER SETUP 

Run the Chapter 3 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual 

ABOUT HYDROLOGY METHODS 

In SSA the input specifications for each Hydrology method are different. If you choose the SCS TR-55 method 

you are required to specify surface characteristics that affect time of concentration for each subbasin. Rain gauge 

data is required to specify the quantity of water produced by the storm event used in your analysis.  If you choose 

Rational method you will use the FDOT provided IDF Curves to specify the rainfall intensity of a storm type for 

the location of your site.   

This section of the training guide provides a brief overview on how SSA is configured to use subbasins and 

rainfall data sources for the SCS TR-55 method and the Rational method. The example we use to perform an 

Analysis of the network later in this training guide will use the Rational method. 
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SCS TR-55 METHOD 

 

When the SCS TR-55 Method is selected in the Project Options the Data Tree displays Subbasins and Rain 

Gages nodes. Subbasins are where you can setup weighted curve numbers. 

 

RAIN GAGES 

Rain gages supply rainfall data for one or more subbasins in the study area. The rainfall data can either be a 

user-defined time series or described in an external file. Several different popular rainfall file formats are 

supported, as well as user-defined formats. 

The principal input data of a rain gage include: 

• Rainfall data type (e.g., intensity, volume, or cumulative volume) 

• Recording time interval (e.g., hourly, 15-minute, etc.) 

• Source of rainfall data (input time series or external file) 

• Name of rainfall data source 
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FDOT Drainage Manual makes reference to NOAA as a source for Rainfall Data: 

https://hdsc.nws.noaa.gov/hdsc/pfds/pfds_map_cont.html?bkmrk=fl  

 

https://hdsc.nws.noaa.gov/hdsc/pfds/pfds_map_cont.html?bkmrk=fl
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RAINFALL DESIGNER 

SSA includes a Rainfall Designer which allows you to select any location within the USA and it will provide 

the design rainfall for the specified storm frequency. Alternatively, a user-defined rainfall can be specified. 

Then the appropriate storm distribution is selected and the design storm is then created. Multiple design 

storms can be created. 

The Rainfall Designer provides the following capabilities: 

• Automatically determines design rainfall (based upon study location) for 1, 2, 5, 10, 25, 50, and 100 

year return frequencies 

• Defines any storm duration 

• Multiple storm events can be created 

• Numerous storm distributions, including SCS, Huff, Eastern Washington, Florida, Chicago Storm, 

Hurricane Hazel, etc. 

 

Example screenshot of Rainfall Designer. To access, click the Rainfall Designer button from the Time Series 

dialog box. 
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RATIONAL METHOD 

 

When the Rational Method is selected in the Project Options the Data Tree displays Subbasins and IDF Curves 

nodes as shown below. 

  

RAINFALL IDF CURVES ZONES 

Note State Kit location of IDF Curves C:\FDOT20XX.C3D\Data\SSA\IDF Curve\. 

FDOT Drainage Manual Figure B-1 shown below is a map of Florida broken into zones. 

http://www.fdot.gov/roadway/Drainage/files/IDFCurves.pdf 

 

http://www.fdot.gov/roadway/Drainage/files/IDFCurves.pdf
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Exercise 3.1 Project Options 

 Start SSA double clicking the desktop shortcut . 

 Double click the Project Options node in the Data Tree to open the Project Options dialog.  

 

 Make the following changes in the General tab of the Project Options dialog: 

a. Hydrology runoff specifications 

✓ Set the Hydrology method to Rational. 

✓ Set the Time of concentration (TOC) method to SCS TR-55. 

✓ Set the Minimum allowable TOC to 10 min. 

b. Hydraulic routing specifications 

✓ Set the Link routing method to Kinematic Wave. 

 Leave all other settings in the General tab unchanged. Click OK. 
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Exercise 3.2 Analysis Options 

 

 Double click the Analysis Options node in the data tree to open the Analysis Options dialog.  

 On the General tab set the duration for a 24hr period by changing the following options: 

a. Under Dates change the Start analysis on: to today's date. 

b. Under Dates change the End anaysis on: to tomorrow's date. 

c. The Analysis duration should now display 1d indicating one day (24hrs). 

  



Chapter 3 ____________________________________________________________________________________ SETUP IN SSA 

3-8 ©2018 FDOT FDOT Civil 3D Drainage & SSA  

Note In the FDOT Drainage Manual Table 3.1 a 3-year frequency is specified for General design. 

 

 In the Storm Selection tab of the Analysis Options dialog, set the radio button to Single storm analysis 

and the Use return period: to 3 years using the dropdown list. 

Note In this example you are using the Rational Method enabling the Single storm analysis option in this dialog 
to specify the storm intensity for analysis. 

 

 Make no other changes and click OK to dismiss the Analysis Options dialog. 

  



SETUP IN SSA ____________________________________________________________________________________ Chapter 3 

FDOT Civil 3D Drainage & SSA  ©2018 FDOT  3-9 

 Save the Project 

 

 From the File drop down menu and select the Save As command. 

 

 From the Save As dialog box, browse to the ssa folder under the Drainage folder and type the file 

name Proposed Drainage - SR61.spf:   

C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed Drainage - SR61.spf 

 Close SSA. 
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4 IMPORT HYDRAFLOW STORM 
SEWER STM FILE 

DESCRIPTION 

This chapter introduces the process of importing Hydraflow Storm Sewers STM files 

OBJECTIVES 

In this chapter, you will learn about: 

• Importing STM files 

• Reviewing Log files 

• Saving the Project 

CHAPTER SETUP 

Run the Chapter 4 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual. 

Exercise 4.1 Import .STM File 

 Start SSA by double clicking the desktop shortcut . 

 Start SSA and open the project file C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed 

Drainage - SR61.spf. 

 Click the File drop-down menu, hover over Import, select Hydraflow Storm Sewers File 
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 Do you want to update existing project?  Click the Yes button if this box appears. 

 

Note The current project has been preconfigured for Project Options and Analysis Options.  Rather then having 
to redo those settings  answer Yes to update the existing project. 

 Browse to the ssa folder under the C:\Civil 3D 20XX Projects\22049555201\Drainage folder and click 

on the file name Proposed Drainage - SR61.stm 

 Review Log File 

 

a. The Log File tab displays the results of the imported STM file. 
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b. Click the Yes button.  There is no other place to access this information at a later time other 

than the saved log file so it is highly recommended that you save the log file. 

 

c. The Save Log File displays with the suggested file name formatted with today's date and time.  

Browse to the ssa folder under the Drainage folder of the project and click the Save button 

without changing the default name. 

 

Note The Log File tab displays the log file from the STM File import process. It is important to review the Elements 
Imported section to make sure all the Subbasins were imported.  The pipes are twice as many as you 
designed in Civil 3D since a bypass link is added for each inlet. Later in this training guide you will connect 
bypass links with the appropriate inlets replacing the bypass links and outfalls shown in the log file.  
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  Review the Plan View tab. 

 

a. The Plan View tab displays the graphical representation of nodes and links from the imported 

STM file.  

 

b. Hover over a red node to display the Node ID in its tool tip. The red node represents an Outfall.   

 

c. Hover over the link connected to the Outfall to display the Link ID of the conveyance link. The 

conveyance link connected to the Outfall represents the bypass link connecting the Inlet to the 

Outfall which was automatically created by the Import STM process.  
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d. Hover over the gray node to display the Node ID of the Inlet. 

  

e. Hover over the green node to display the Subbasin ID connected to the Inlet. 

 Save the Project. 

 

a. Click the File drop down menu and select the Save As command. 

 

b. The Save As dialog box displays. Browse to the ssa folder under the Drainage folder and type 

the file name Proposed Drainage - SR61.spf.   

C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed Drainage - SR61.spf 

 Close SSA 
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5 DISPLAY CAD FILE & ELEMENT 
LABELS 

DESCRIPTION 

This chapter introduces how to display a CAD file and element labels in SSA 

As you work in SSA you will find that keeping organized and aware of how elements are connected is very 

important to working efficiently and avoiding mistakes. In this chapter you will display your Civil 3D drawing 

as a background for your network in SSA. You will also learn how to display ID labels for nodes and links. Then 

you will move the subbasin nodes inside the catchment polygon areas. 

OBJECTIVES 

In this chapter, you will learn about: 

• Assigning a Background Drawing 

• Displaying Node and Link ID Labels 

• Move Subbasin Nodes next to Catchment Labels 

CHAPTER SETUP 

Run the Chapter 5 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual. 

Exercise 5.1 Assign Background Drawing 

 Start SSA and open the project file C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed 

Drainage - SR61.spf. 

 Click the View pull-down menu and choose Layer Manager. 
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 In the Layer Manager dialog you will see the Background Image/CAD file: field is empty.  Click the 

ellipsis button (as indicated by the red box) to browse for a CAD file. 

  

a. Browse to the Drainage folder:   C:\Civil 3D 20XX Projects\22049555201\Drainage. 

b. Select the  DRPRRD05.dwg file and Click OPEN. 
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 The Background Image/CAD file field displays the path and file name you just selected.  Click OK to 

dismiss the Layer Manager dialog. 

 

 From the View pull-down menu and choose Zoom Extents. 
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 The Plan View tab displays the CAD file background and the design elements. Zoom into the area as 

indicated by the red box. 

  

 Click the View pull-down menu and select the Zoom command.  There is no red box on your screen. 

The red box was placed on the screen capture as a point of reference. Click on the canvas in the 

approximate location of the upper left and lower right corners of the red box.  

Note Being familiar with the zoom command in AutoCAD is helpful since the SSA Zoom command behaves 
similar to the Zoom Window command in AutoCAD. 
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 Your display should now look similar to this screen capture. Click the ESC key to terminate the zoom 

command. 

 

 Click the View pull-down menu and open the Layer Manager dialog box again.  Click the CAD 

Layers button in the upper right corner of the dialog to open the CAD Layers dialog. 
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  Click the Layers Off button. Check the boxes in the Visible column as indicated below.  

 

 Additionally, scroll down to find the TextLabel layer and check the box.You may need to click the 

Layer Name column heading to sort the list alphabetically.  Click OK twice.  

 

 Zoom in.  You should now see the nodes and links on top of the catchment areas from the background 

CAD file.   

 Select the Save command under the File pull-down menu to save your SSA project. 
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Exercise 5.2 Display Node and Link ID Labels 

Nodes and Links have IDs that can be displayed as labels in the Plan View tab. 

 Click the View pull-down menu and select the Display Options command. 

 

 The Display Options dialog box displays.  Find the Annotation section of this dialog.   

 

 Check the box next to Subbasin IDs, Node IDs, Link IDs.  Click OK to dismiss the Display Options 

dialog. 
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 The labels overlap at this zoom scale. Try zooming in to where the labels do not overlap.  

 

 Use the wheel on the mouse to pan and zoom into the northern most Inlets S-(9) and S-(10). Now the 

Catchment areas with their labels displays as background from the CAD file. Click the Save button. 
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Exercise 5.3 Move Subbasin Nodes Next to Catchment Labels 

You can move nodes in SSA by  clicking and dragging them.  In this section you will move the subbasin nodes 

next to the corresponding Catchment label displayed by the background CAD file. 

 When you hover over Subbasin Sub-S-(9) a tool tip appears with a green background. The tool tip 

displays the type of node (Subbasin) and the Node ID (Sub-S-(9)). Left click the green square 

representing the subbasin node and left mouse drag it next to the label Catchment - (S-9) as indicated 

by the red arrow. 

  

 While still selected the subbasin node flashes green and purple.  Click ESC to deselect the subbasin.  

Note Why move the node? The reasons are mostly cosmetic in nature. You are  organizing the content on the 
canvas so it appears to be in the correct location. The position does not effect the analysis.  

Continue moving the remaining subbasin nodes next to their corresponding Catchment label to 

complete the exercise. 
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 This screen capture is an example of what the moved positions of the subbasin nodes might look like 

when you are done. Click the Save button to save the SSA project.  

 

 Close SSA. 

 

 Save changes made to current project?  Click the Yes button if this dialog appears. 

Note If you wish to skip this exercise I have saved a copy of the SSA Project with the completed task. Proposed 
Drainage - SR61 - moved subbasin nodes.spf in C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa. 
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6  DRAW BYPASS LINKS FOR INLETS 
SET ON GRADE 

DESCRIPTION 

This chapter you'll work in a methodical fashion to create bypass links, implement a naming convention for the 

bypass links, and delete the Outfall nodes created by the Import STM file process. 

The suggested naming convention used in this task is not a requirement just a helpful suggestion for keeping 

organized with minimal effort by utilizing names automatically created by the software. 

This method of creating bypass links and deleting Outfall nodes can help you pick up where you left off if you 

are interrupted while creating bypass links.  The remaining Outfalls will indicate which bypass links have not 

been renamed. 

OBJECTIVES 

In this chapter, you will learn about: 

• Drawing Conveyance links 

• Deleting Outfall Nodes 

• Connecting Inlets 

• Replacing Bypass Link names 

CHAPTER SETUP 

Run the Chapter 6 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual. 
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Exercise 6.1 Draw the Conveyance Link from Upstream to Downstream Inlets 

Inlets on grade do not capture all the runoff. Some runoff will continue along the gutter of the roadway to the 

next downstream inlet. This gutter flow is call bypass flow. To account for this behavior, you must hydraulically 

connect upstream and downstream inlets with a bypass link.  A bypass link is a conveyance link just like a pipe 

is a conveyance link. 

 

For all bypass links in this Manual set the Shape to Direct in the Conveyance Links dialog as shown in the 

above example. In our examples using the Direct setting will simplify our workflow. 

 Start SSA and open C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed Drainage - 

SR61.spf 

 From the Elements toolbar use the Add Conveyance Link command. 

 

 Draw the vertices of the bypass link so they are clearly visible separately from the pipe.  

Note It is not necessary to have the bypass link directly on top of the pipe. The purpose is to connect an upstream 
inlet to the appropriate downstream inlet receiving the bypass flow. Keep in mind the downstream inlet for 
bypass flow may be different than the downstream node of the pipe. The image below shows the pick 
points represented by red circles. Bypass flow from S-(9) flows along the median gutter to S-(8). The from 
and to points are all that matter to SSA not the position of the link vertices.  

Allow the software to automatically assign the Link ID. You will rename the links in a later step. 
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 Draw bypass links for each of the remaining inlets from upstream to downstream using the Add 

Conveyance Link command.  Use the screen captures below as a guide for each bypass link. 

a. S-(9) to S-(8) and S-(10) to S-(11) 

 

b. S-(8) to S-(7) and S-(11) to S-(12) 

 

c. S-(7) to S-(6) and S-(5) to S-(6) 
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d. S-(4) to S-(5) and S-(13) to S-(12) 

 

e. S-(3) to S-(2) and S-(1) to S-(2) and S-(16) to S-(13) 

 

 Save the SSA project 
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DELETE THE OUTFALL NODES REPLACED BY THE BYPASS LINKS. 

When the .stm file is imported the bypass link initially assigned to the Inlet goes to an Outfall node labeled 

OFFSITE-xx. You will replace this outfall and link with the bypass link created in a previous exercise. The 

bypass link hydraulically connects the upstream inlet to the downstream inlet. 

Note You can save some editing if you  assign the outfall link name to the newly created bypass link connected 
to the downstream inlet.  You can avoid having to edit the Inlet properties to re-assign the bypass link if 
you  rename the bypass link using the same name of the link currently connected to the outfall. After 
deleting the outfall node the connected conveyance link is also deleted.  Duplicate names are not allowed 
in SSA so you must delete the link before reusing its name. 

USE A NAMING CONVENTION FOR BYPASS LINKS TO REDUCE CONFUSION  

Prefix the pipe name with L- for the bypass link name when the bypass link connects the same nodes as the 

pipe.  For example: Pipe name is Pipe-(5) therefore the bypass link name is L-Pipe-(5) 

When the bypass link does not follow the pipe path use the upstream structure name prefixed with L-bypass-

. For example: Bypass link connecting S-(9) to S-(8) is named L-bypass-S-(9). 

Having similar names for the Pipe (conveyance link) and the bypass link can be a great help in keeping 

organized and aware of how parts of the network are connected.  Graphically it is easy to see the relationship 

but looking at names in a table in a dialog box is not so easy to keep track of those relationships.   

If the clipboard copy/paste sequence is not your preferred method of making the edits just keep in mind the 

similar naming formats when you manually rename the conveyance links.  This naming convention is not a 

requirement just a helpful suggestion for keeping organized minimizing effort by utilizing names 

automatically created by the software. 

Exercise 6.2 Replace Bypass Link Name with Outfall Conveyance Link Name 

Link-02 is drawn from S-(10) to S-(11) as is PIPE-(9). Notice the name of conveyance link L-PIPE-(9) to outfall 

OFFSITE-3 is similar to the name of the pipe PIPE-(9). You can copy the link name L-PIPE-(9) to the clipboard 

before deleting the outfall OFFSITE-3. Finally edit Link-02 and paste the name L-PIPE-(9) replacing the name 

Link-02. Now use the step by step process below to experience this workflow. 

 Double click L-PIPE-(9) to open the Conveyance Links dialog. 
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 Highlight and Copy the Link ID L-PIPE-(9) to the Windows clipboard. Close the Conveyance Links 

dialog. Click the Close button. 

 

 Select outfall OFFSITE-3, right click then select Delete.  

 

 From the dialog, click Yes to delete OFFSITE-3. 

 

 Double click the Link-02 conveyance link to open the Conveyance Links dialog. 
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 Highlight and Paste the clipboard contents in the Link ID field to replace Link-02 with L-PIPE-(9).  

 Change the Shape to Direct. Click the Close button. 

 Double click the upstream node S-(10) to open the Inlets dialog.  

 

 Verify the Roadway/gutter bypass link is set to L-PIPE-(9). Click the Close button. 

Note This workflow can help you pick up where you left off if you are interrupted while creating bypass links.  
The remaining Outfalls will indicate which bypass links have not been renamed. 
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 Use a naming convention for bypass links to reduce confusion  

 

Note Having similar names for the Pipe (conveyance link) and the bypass link can be a great help in keeping 
organized and aware of how parts of the network are connected. This naming convention is not a 
requirement just a helpful suggestion for keeping organized minimizing effort by utilizing names 
automatically created by the software. 

 

 Continue deleting the Outfall nodes one at a time as you rename each bypass link. The only outfall in 

this pipe network is at Pipe-(6) which flows out from structure S-(12).  All other Outfall nodes should 

be deleted, OFFSITE-4, OFFSITE-1, and OFFSITE-6. The final list of Link IDs is shown above.  

Note Double click any link to open the Conveyance Links dialog. At the bottom of the dialog you will find the list 
of Link IDs  

 Double click inlet S-(9) to open the Inlets dialog. Use the scroll bar on the right side of the table at the 

bottom of the dialog to scroll to the top of the list. Verify the upstream node has the correct bypass link 

assigned. 
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Note S-(12) is SAG inlet and has no bypass link. 

 

 Stay in the Inlets dialog, scroll through the list one at a time, review the Inlet ID and assign 

Roadway/gutter bypass link. The results should match the list below: 

✓ S-(11) is assigned bypass link L-PIPE-(10). 

✓ S-(10) is assigned bypass link L-PIPE-(9). 

✓ S-(9) is assigned bypass link L-bypass-S-(9). 

✓ S-(13) is assigned bypass link L-PIPE-(5). 

✓ S-(3) is assigned bypass link L-PIPE-(2). 

✓ S-(4) is assigned bypass link L-bypass-S-(4). 

✓ S-(16) is assigned bypass link L-PIPE-(16). 

✓ S-(1) is assigned bypass link L-bypass-S-(1). 

✓ S-(2) is SAG inlet and has no bypass link. 

✓ S-(6) is SAG inlet and has no bypass link. 

✓ S-(7) is assigned bypass link L-PIPE-(13). 

✓ S-(8) is assigned bypass link L-bypass-S-(8). 

✓ S-(7) is assigned bypass link L-PIPE-(13). 

✓ S-(5) is assigned bypass link L-PIPE-(7). 
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 Change the Inlet location to On Sag for S-(6), and S-(2). Click the Close button. 

 

 Save the SSA project and Close SSA. 
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7 RUN ANALYSIS FOR ASCII OUTPUT 
REPORT 

DESCRIPTION 

The drainage network is defined and ready to run an analysis for a storm event. This chapter describes how to 

specify options to be used in the analysis and how to run the analysis. 

OBJECTIVES 

In this chapter, you will learn about: 

• Setup Analysis for Rational Method 

• Check Analysis Options 

• Specify the IDF Curves 

• Running an Analysis 

• Typical Errors to Resolve 

CHAPTER SETUP 

Run the Chapter 7 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual. 

FROM THE SSA HELP FILE 

Select ANALYSIS > PERFORM ANALYSIS or click the PERFORM ANALYSIS icon from the Standard 

toolbar. Before the software begins the simulation, the built-in Model Checker reviews the defined input data for 

any omissions or potential problems with the model data. If it encounters an error with the input data, it will 

explain what is wrong and how to correct it. The Model Checker can be thought of as an expert modeler, pointing 

out any errors contained within the model. 
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Exercise 7.1 Setup Analysis  

➢ Setup Hydrology Method in the Project Options 

 Start SSA and open the project file C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed 

Drainage - SR61.spf. 

 Double click the Project Options under Project Data in the Data Tree to open the Project Options 

dialog. 

 

 Set the Hydrology method to Rational.  Set the Minimum allowable TOC to 10 min.  Click OK. 

   

 When the Rational Method is selected in the Project Options, the Data Tree displays Subbasins and 

IDF Curves nodes under the Hydrology branch. 
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➢ Check Analysis Options 

 Double click the Analysis Options under Project Data in the Data Tree to open the Analysis Options 

dialog. 

 

 On the General tab check your Dates area to make sure you have 1 day for the Analysis duration. 

Click OK. 
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 Check the Storm Selection tab to make sure you have specified a Single storm analysis and set the Use 

return period to 3 years. The Description you enter will appear in the Analysis output.  Click OK. 

 

➢ Specify the IDF Curves for the Project 

The Rational Method uses IDF Curve data instead of rain gage data. See page 418 in the SSA Help File, 

Chapter 9, Subbasin Element Data, IDF Curves for more a more detailed explanation of IDF Curves. 

The FDOT Civil 3D State Kit provides IDF Curves files in a SSA compatible format which can be found in 

the following folder. C:\FDOT20XX.C3D\Data\SSA\IDF Curve\ 

The IDF Curve Data Files are organized by Zones. The FDOT Drainage Manual Figure B-1 shows the IDF 

Curve Zones on a map of Florida:  http://www.fdot.gov/roadway/Drainage/files/IDFCurves.pdf. 

The map below shows our project in Wakulla County is located in Zone 2.  

 

http://www.fdot.gov/roadway/Drainage/files/IDFCurves.pdf
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 Double click the IDF Curves under Project Data in the Data Tree to open the IDF Curves dialog. 

Click the Load button in the upper right corner of this dialog. 

 

 Using the Load IDF Curves dialog, browse to the folder C:\FDOT20XX.C3D\Data\SSA\IDF Curve\ 

and select the file FL IDF Zone 2.idfdb. Click the Open button to return to the IDF Curves dialog. 

 



Chapter 7 _________________________________________________________ RUN ANALYSIS FOR ASCII OUTPUT REPORT 

7-6 ©2018 FDOT FDOT Civil 3D Drainage & SSA  

 Change the ID to IDF-Zone2. Set the Period to 3 years. Leave all other settings as shown below.  Click 

the Close button in the lower right of the dialog. 
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Exercise 7.2 Run Analysis 

 From the Standard toolbar, select the Perform Analysis command. 

 

 If there are errors in the Perform Analysis dialog the Anaysis status will display a message Analysis 

was unsuccessful. Click OK and the ASCII Output Report tab displays. 

 

 

Note ERROR 601: Inlet nnn has invalid by-pass link. 

The BYPASS LINK entry defines the ID of the link that receives any flow that bypasses the storm drain inlet. If 
the inlet location is defined as located ON SAG, then this entry is grayed out since there is no bypass link 
for sag inlets. The provided drop-down list provides a listing of links (e.g., channels, pipes, pumps, orifices, 
weirs, or outlets), allowing you to select the bypass link. 
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 Double click S-(1) to open the Inlets dialog. The bypass link is not assigned. Set the Roadway/gutter 

bypass link to L-bypass-S-(1). Click Close. 
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 Rerun Analysis. From the Standard toolbar, Select the Perform Analysis command. 

 

 If there are errors in the Perform Analysis dialog the Anaysis status will display a message Analysis 

was unsuccessful. Click OK and the ASCII Output Report tab displays. 

 

 

Note ERROR 600: On grade Inlet nnn does not have two outlet links. At least one stormwater sewer pipe and a 
bypass gutter link must be defined. 

 



Chapter 7 _________________________________________________________ RUN ANALYSIS FOR ASCII OUTPUT REPORT 

7-10 ©2018 FDOT FDOT Civil 3D Drainage & SSA  

 Double click on  S-(12) to open the Inlets dialog.  The Inlet location shows On Grade.  S-(12) is a sag 

Inlet. Sag Inlets don't require 2 outlets as indicated by ERROR 600. The Inlet Location drop down list 

is grayed out.   
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 To correct this problem, you must change the Inlet manufacturer. Choose FHWA HEC-22 Generic 

from the Inlet dialog.  Set the Inlet Location to On Sag. 

 

 Rerun Analysis. From the Standard toolbar, select the Perform Analysis command. 

 

 If there are errors in the Perform Analysis dialog the Anaysis status will display a message Analysis 

was unsuccessful. Click OK and the ASCII Output Report tab displays. 
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 Click the Error Messages link in the Bookmarks panel to navigate to the bottom of the report. 

 

Note ERROR 131: The following links form cyclic loops in the drainage system.The Steady and Kinematic Wave 
flow routing methods cannot be applied to systems where a cyclic loop exists (i.e., a directed path along a 
set of links that begins and ends at the same node). The same is true for Hydrodynamic routing 
when water quality analysis is performed. 

In this case the pavement gutter is bypassing S-(3) and flowing toward S-(2) (which is a sag inlet) but the 
pipe connected to S-(2) flows to S-(3).  The design is correct but the internal logic in SSA views the bypass 
link to be pointing to an upstream node which it deems invalid. Ultimately the bypass flow from S-(3) will 
go downstream to S-(13) and we must configure the bypass link for S-(3) to agree with this logic. 
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 Click L-PIPE-(2) to select it then right click L-PIPE-(2) to display the popup menu, then select the 

Connect From/To command. 

 

 The Connect From/To box opens and provides instructions on how to use the command. Click OK.  

  

 Click the S-(3) node first then click the S-(13) node. The bypass link is now hydraulically connecting 

the correct inlets but the vertices need to be adjusted to cleanup the display. 
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 Right click L-PIPE-(2) to display the popup menu and choose Edit Vertices. 

  

  A black node appears at the current vertex. A white node appears at all other vertices.  
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 Click the white vertex nearest S-(2) and drag it toward S-(13) and place the vertex so the bypass 

geometry resembles other bypass links. Press ESC to finish the command. 

  

 Rename the bypass link  L-PIPE-(2) to L-PIPE-(17).  Select the bypass link. Double click the node to 

open the Conveyance Links dialog and edit the Link ID. Click the Close button. 
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 Since you renamed the bypass link the previous name is still assigned to S-(3). Double click S-(3) node 

to open the Inlets dialog. Click the Roadway/gutter bypass link drop-down list and select L-PIPE-

(17). Click the Close button. You will finish the analysis in Exercise 7.3.  
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TYPICAL ERRORS TO RESOLVE. 

• Add Missing Bypass Links 

• Correcting Flow Direction Errors 

• Correcting Adverse Slopes 

An ASCII Output Report is available after each analysis, as shown in the following figure. Select OUTPUT 

ASCII OUTPUT REPORT or click the ASCII OUTPUT REPORT icon from the Output toolbar to view the 

report of the analysis model run.  

 

The ASCII Output Report will include an error statement, code and description of the problem encountered.  For 

Example:  ERROR 138 – JUN-32 has initial depth greater then maximum depth.  

Note See Page 96 Chapter 4 Network Analysis in the SSA Help file to find a list of the Error Codes with an 
explanation of each one. 
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ADD MISSING BYPASS LINK 

This is an example where I intentionally deleted the by-pass link then ran the Analysis to generate the error. This 

example has no steps for the user to perform. It is intended to illustrate a situation which you will encounter and 

need to be aware of its remedy. 

 

When you get a message Analysis was unsuccessful click OK and review the output report displayed on the 

ASCII Output Report tab. 

  

The error shown above indicates the by-pass link specified for inlet S-(1) is not valid. 
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To troubleshoot this error, pan and zoom to Inlet S-(1) on the Plan View tab. Pipe-(1) connects S-(1) to S-(16) 

but there is no bypass link to connect S-(1) to S-(2). You have an example in a previous section showing you 

how to create a bypass link. 

Below is another report showing a more verbose explanation of Error 600.  

 

Note ERROR 600 : On grade Inlet S-208 does not have two outlet links. At least one stormwater sewer pipe and 
one gutter bypass link must be defined. 

It is easy to view the errors within the ASCII Output Report and understand what needs to be done next.  In 

this case we need to draw a bypass link and connect it to the upstream inlet.  Correcting errors is an iterative 

process but produces the necessary configuration to complete the analysis without errors. 
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CORRECTING FLOW DIRECTION ERRORS 

Swap the Upstream and Downstream nodes to correct flow direction errors. 
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CORRECTING ADVERSE SLOPES 

The Conveyance Links dialog shows the Inlet invert elevation at 28.87. 

 

In this example I edited the inlet invert elevation to lower it below the Outlet invert elevation (now at 25.87).  
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When the Analysis is run you can see the warning in the ASCII Output Report. 

 

Note WARNING 116 : Conduit inlet invert elevation defined for Conduit PIPE-(1) is below upstream node invert 
elevation.                Assumed conduit inlet invert elevation equal to upstream node invert elevation. 

The warning indicates a situation where the upstream invert elevation is lower than the downstream invert 

elevation.  To correct the problem open the Conveyance Links dialog for PIPE-(1) and edit the inverts to produce 

a positive slope value. 

The profile view can also help you choose an invert elevation that works without causing further errors upstream 

or downstream. Profile Views will be covered in a later chapter. 

Note SSA Help File page 227 Chapter7 Network Element Data,  Channel, Pipe, & Culvert Links  

ADVERSE SLOPE 

For both Steady Flow or Kinematic Wave routing, all channels, pipes, and culverts must have positive slopes 

(i.e., the outlet invert must be below the inlet invert). The software will check for this condition when it 

performs the analysis and will report this as a problem. 

If you have incorrectly defined the inlet and outlet nodes for a link, you can easily correct this. Select the 

reversed link in the Conveyance Links dialog box and click the Swap button. The software will reverse the 

direction of the link so that the outlet node becomes the inlet node and the inlet node becomes the outlet node. 

Alternatively, select the link from the Plan View, right-click to display the context menu, and select 

REVERSE DIRECTION. 

However, if a channel, pipe, or culvert does have an adverse slope (i.e., negative slope), where the outlet 

elevation is higher than the inlet elevation, reversing the direction of the link will not solve this issue. 

Networks with adverse sloped links can only be analyzed with Hydrodynamic routing. 
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SURCHARGED PIPES AND OSCILLATIONS 

Note SSA Help File pg 228 Chapter 7 Network Element Data 

If the upstream end of a pipe surcharges, then a head adjustment is performed by the routing engine at the 

upstream connecting node. Because this head adjustment is an approximation, the computed head at the upstream 

node can sometimes have a tendency to “bounce” up and down (or oscillate) when the pipe first surcharges. This 

bouncing can sometimes cause the analysis results to become unstable; therefore, a transition function is 

automatically used to smooth the changeover of head computations. 

If you find that the oscillation continues at the upstream node while the connected downstream pipe is 

surcharged, then define a PONDED AREA at the downstream connecting node. This can sometimes eliminate 

the oscillation at the upstream node and produce a more stable model. 

Exercise 7.3 Re-Run Analysis 

 From the Standard toolbar, Click the Perform Analysis command. 

 

 If there are no errors the green progress bars appear in the Perform Analysis dialog. 

 

 When the analysis is complete the Analysis status will display Analysis successful message. Click the 

checkbox Save analysis results.  
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 Browse to the folder C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\ by clicking the ellipsis 

button. Keep the default name and click the Save button to return to the Perform Analysis dialog.  

 

 The Solution file allows you to Save the analysis results to a .sol file for later recall. Click OK. 

 

 To review the Solution file click the File pull-down menu and select the Open Results... command. 
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 Select the file you just saved. Click the Open button. 

 

 The output report on the ASCII Output Report tab displays the contents of the .sol file. The bookmarks 

on the left provide a convenient way to navigate to your area of interests within the report. 

 

Note If the ASCII Output Report tab does not display, from the Output Toolbar Click the ASCII Analysis Report 
command. 
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 Click the File drop-down menu and select Save As. 

 

 Save the file using the following name and path: 

C:\Civil 3D Projects\22049555201\Drainage\ssa\Proposed Drainage - SR61-analysis.spf  

 

 Close SSA. 
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8 SHOW PROFILE PLOT 

DESCRIPTION 

This chapter demonstrates the process of showing a profile plot 

OBJECTIVES 

In this chapter, you will learn about: 

• Profile Plot Path Configuration 

• Show Plot 

• Displaying Water Levels 

• Animating the analysis  

• Creating an Excel Table Report 

CHAPTER SETUP 

Run the Chapter 8 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual. 

The Profile Plot makes is it easy to see if pipes are sloped in the wrong direction.  You can edit the pipes and 

nodes by double clicking and viewing the corresponding dialog box to edit values then return to the Profile Plot 

to see the updated results.  
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DATA TREE TOOLBAR 

The Data Tree has 3 buttons in a toolbar at the bottom. Each button changes the display of the Data Tree.  

The left button the Plan View as displayed below. 

 

The middle button is the Time Series Plot. 

 

 

The right button is the Profile Plot. 
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Exercise 8.1 Profile Plot Path Configuration 

Use the Profile Plot window (a docked dialog panel) to configure the Profile Plot path to display the links and 

structures starting at S-(9) and connecting S-(10), S-(11), S-(12), and ending at outlet Out-1PIPE-(6). 

➢ Setup Profile Plot 

 Start SSA and open the project file C:\Civil 3D Projects\22049555201\Drainage\ssa\Proposed 

Drainage - SR61-analysis.spf. 

 Click the Profile Plot button to display the Profile Plot window.   
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 At the top in the Nodes selected for profile plot area, specify the Starting node and Ending node by first 

clicking the blank field next to the Starting node. Your cursor is now focused inside the field allowing 

you to select a structure in the Plan View and have that Structure ID placed in the Starting node field. 

Select Inlet S-(9). The Structure ID S-(9) displays in the Starting node field. 

 

 Select the blank field next to Ending node. Select the Outfall Out-1PIPE-(6). The outfall ID Outfall 

Out-1PIPE-(6) now displays in the Ending node field.  

Note In the Plan View notice the elements connecting S-(9) to Out-1PIPE-(6) are highlighted in magenta.  In the 
List of links in selected profile you see the list of conveyance link IDs matching what is highlighted in the 
Plan View. The software found a series of links connected the starting and ending structures but that is not 
connecting the desired structures.   
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 Read the Note in the Profile Plot. "…If additional control is needed to define the path, then select links 

along the path instead of selecting the ending node."  There are no editing options built into this 

window. To start over you must click the Cancel button, then click the Profile Plot button. 

 

 Click inside the blank field next to the Starting node. Select inlet S-(9). 
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 Click the Conveyance Link PIPE-(18) to begin defining the path to the outfall.  

 

 Continue by picking PIPE-(9), PIPE-(10), and PIPE-(6). 
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➢ Show Plot 

1. Click the Show Plot button. 

 

 The profile from S-(9) to outfall Out-1PIPE-(6) displays.in the Profile Plot tab. 
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Exercise 8.2 Display Water Levels in Pipes 

The water levels and EGL and HGL plots are displayed in the Profile Plot after running the Analysis. 

 From the Standard toolbar, select the Perform Analysis command. 

 

 Clear the Save analysis results check box, and then Click OK.  

 

 The water level, HGL, and EGL displays after completing the Analysis command. You can roll the 

wheel on the mouse to change the horizontal scale of the Profile Plot. 
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 Right click in the Profile Plot area to display the context menu.  Select the Profile Plot Options 

command. 

 

 In the Other display specifications area of the Profile Plot Options dialog you can see the colors 

specified for HGL, Maximum HGL, and Fill water. The check box next to each element enables or 

disables display in the Profile Plot. Click OK to close the Profile Options dialog. 
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Exercise 8.3  Animate Storm Event in the Profile Plot 

Note For additional information see the SSA Help file and refer to page 118 Chapter 5 Display analysis Results 
Output Animation. 

 Click the Output drop-down menu and select the Output Animation command. 

 

 The animation controls are on the Output Animation dialog box. The Date & Time are for the current 

analysis run.  Slide the animation speed all the way to the right. 

 

 Click the Play button to start the animation. Click the Stop button after the elapsed time has reached 

40 minutes. 
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 As the time progressed on the Output Animation dialog, the Profile Plot displayed changes in the 

HGL, Maximum HGL, and water level. 

 

 Using the Slider Control and the Left and Right Arrow buttons at either end are a convenient way to 

navigate to the desired date and time. Click the X to close the Output Animation dialog. 

 

 Close SSA and Save changes to the project. 
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EXCEL TABLE REPORTS 

Note Run the Chapter 11 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when 
completing the exercises in this training manual. 

As shown in the following figure, from the Output toolbar, select OUTPUT EXCEL TABLE REPORTS or click 

the EXCEL TABLE REPORTS icon from the Output toolbar. The software will automatically startup Excel and 

display the output reports. 
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Exercise 8.4 Create an Excel Table Report 

 Start SSA and open the project file C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed 

Drainage - SR61-analysis.spf. 

 On the far right of the Output toolbar, select the Excel Table Reports command. 

 

 Excel opens and displays the available reports organized by tabs in a single workbook. Click the X 

button to Close Excel and don't save changes. 

 

 Close SSA and Save changes to the project. 
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9 IDENTIFY SURCHARGED PIPES 

DESCRIPTION 

This chapter shows how to identify surcharged Pipes. The user interface in SSA highlights elements and values 

in dialog boxes in red when a surcharged condition exists. 

OBJECTIVES 

In this chapter, you will learn about: 

• Changing Frequency 

• Run Analysis 

• Identifying surcharged elements 

CHAPTER SETUP 

Run the Chapter 9 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual. 
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Exercise 9.1 Identify Surcharged Pipes 

➢ Change the Frequency 

 Start SSA and open the project file C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed 

Drainage - SR61-analysis.spf. 

 Double click Analysis Options to open the Analysis Options dialog. 

 

 Click the Storm Selection tab.  Change the Use return period drop-down list to 50. Click the OK 

button. 
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➢ Run Analysis 

 From the Standard toolbar, select the Perform Analysis command. 

 

 Clear the Save analysis results check box, and then click OK. 

 

➢  Display the Plan View Tab 

 Select the Plan View tab, notice PIPE-(6) is highlighted in red.  This indicates the pipe is surcharged. 
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➢ Display PIPE-(6) in Conveyance Links Dialog 

The Conveyance Links dialog box provides a section titled ANALYSIS SUMMARY that provides a brief 

summary of the simulation results for the selected channel, pipe, or culvert link, as shown in the following 

figure. 

1. Double click PIPE-(6) in Plan View to display the Conveyance Links dialog.  The fields with the red 

background indicate the values that are surcharged. 

 

 

Note From the SSA Help File, Page 118  Chapter 5,  Display Analysis Results, Input Dialog Boxes 

For link elements that are experiencing surcharging, or node elements that are experiencing flooding, the 
analysis summary output fields will change the background color to red in order to help you find those 
elements that should be reviewed for adequacy. 

For storm drain inlets, in the Inlet dialog box Analysis Summary section the software assumes that if more 
than ½ of the roadway lane is covered with stormwater from gutter spread, that the inlet capacity is not 
sufficient. 
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 Change the PIPE-(6) diameter to 24" and re-run the Analysis to resolve the surcharge condition.  
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 Double click PIPE-(6) in Plan View to view the results the Conveyance Links dialog.  (Using the 

50yr Return Frequency). Click Close. 

 

 Use the Save As command to Save the SSA project to a new file name Proposed Drainage - SR61 - 

final.spf. 

 

 Close SSA and Save changes to the project. 
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10 EXPORT/ IMPORT STM FILE FROM 
SSA TO CIVIL 3D 

DESCRIPTION 

This chapter will review the process of exporting a STM file from SSA and the process of moving the pipe 

network to Civil 3D. 

OBJECTIVES 

In this chapter, you will learn about: 

• Exporting an STM file from SSA  

• Set Civil 3D Storm Sewers Migration Defaults 

• Import a STM File into Civil 3D 

CHAPTER SETUP 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual. 

Exercise 10.1  Export to a STM File From SSA 

Run the Chapter 10 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

 Start SSA and open the project file C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed 

Drainage - SR61-final.spf. 

 Click the File pull-down menu, hover over Export and select Hydraflow Storm Sewers File. 
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 Browse to the ssa folder under the Drainage folder and create a new file:  

C:\Civil 3D 20XX Projects\22049555201\Drainage\ssa\Proposed Drainage - SR61 - exportfromssa.stm. 

 

 Click the Yes button. 

 

  Use the default file name created by the program. Click the Save button. 
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 View the log file on the Log File tab. 

 

 Close SSA and save changes to the project. 
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PIPE NETWORKS 

Pipe networks imported from the Hydraflow Storm Sewers STM file format to Civil 3D can contain hydraulic 

property information, such as hydraulic grade lines (HGL) and energy grade lines (EGL) which is part of the 

reason why we use SSA, for better analysis of our design.  

The following values are calculated in the Storm Sewers Extension version 2010 and beyond, but are not found 

in older versions of .stm files (prior to 2010): 

• Pipes 

o Energy Grade Line Up 

o Energy Grade Line Down 

o Flowrate 

• Structures 

o Energy Grade Line 

o Known Capacity 

 

In the Storm Sewers Extension, the list of pipe sizes is hard coded and cannot be customized. This list does not 

distinguish between inner and outer pipe diameter, pipe material, or pipe class, as does AutoCAD Civil 3D.  

MATCHING NETWORK NAMES & PART NAMES 

When you import the .stm file, if any of the pipe network names in the .stm file match pipe network names in 

the AutoCAD Civil 3D drawing, you must choose to either create new pipe networks, or update existing pipe 

networks. Rules are not applied to pipes or structures when importing pipe networks from either LandXML or 

from the Hydraflow Storm Sewers STM file format.  

As a beneficial workflow we will Save As the existing drawing with a new name so we can preserve the content 

that existed prior to editing in SSA and compare that to the revised Pipe Network data that returns from SSA to 

Civil 3D, overwriting the existing data that matches the part names of incoming data. 

Note During the creation of this training manual, an MR2 update to the FDOT Civil 3D 2018 Kit was released, 
This MR2 release contains new FDOT Pipe and Structure databases. We have created a new 
DRPRRD06.dwg file which contains these updates.  
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Exercise 10.2 Open and Save As the DRPRRD06.DWG File 

Run the Chapter 11 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

 Start Civil 3D by double clicking the  shortcut from your desktop. 

 Click the Application menu, then hover over Open and select Drawing. 

 

 Browse to the C:\Civil 3D 20XX Projects\22049555201\Drainage folder and select DRPRRD06.dwg.  

Click the Open button. 
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 Click the Application menu and hover over Save As then select Drawing. 

 

 Browse to the C:\Civil 3D 20XX Projects\22049555201\Drainage folder and type DRPRRD07.dwg in 

the File name field. Click the Save button to create: 

C:\Civil 3D 20XX Projects\22049555201\Drainage\DRPRRD07.dwg. 
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Exercise 10.3  Set Civil 3D Storm Sewers Migration Defaults 

Pipe networks imported from the Storm Sewers Extension can contain hydraulic property information, such as 

hydraulic grade lines (HGL) and energy grade lines (EGL) and more. 

➢ Edit Feature Settings 

 In the Toolspace select the Settings (tab). Right click on Pipe Network and select Edit Feature 

Settings. 

 

 Set the Allow Part Family Swapping to No and the Use Imported Part Id for Part Family to No, then 

click OK. 

 

Note Part Family Swapping is disabled with these settings so you can  update the existing structures and pipes 
in Civil 3D. 
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➢ Import STM File in Civil 3D 

 From the Insert tab > Import select the Storm Sewers command. 

 

  Browse to the ssa folder under the C:\Civil 3D Projects\22049555201\Drainage folder and select the 

file Proposed Drainage - SR61 - exportfromssa.stm. 

 

 Click Update the existing pipe network. 

 

 No errors display in the Event Viewer. 
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 Grip PIPE-(6) and select the Pipe Properties command in the ribbon. 

 

 Open the Pipe Properties for PIPE-(6).  The Hydraulic Properties have been updated. The Inner Pipe 

Diameter is now 24" Click OK to close the dialog.  Press ESC to clear the grips on PIPE-(6). 
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 Grip Inlet S-(12) and Click Structure Properties from the ribbon. 

 

 On the Part Properties tab scroll down to the Hydraulic Properties. Notice the Hydraulic Grade Line 

and Energy Grade Line are now populated with calculated values imported from SSA.  Click OK.  

Click ESC to clear the grips. 

 

 Save the file and Close Civil 3D 
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11 Viewing HGL and EGL in Profile View 

DESCRIPTION 

This chapter covers the steps to view both HGL and EGL in the Profile View 

OBJECTIVES 

In this chapter, you will learn about: 

• Edit Pipe Styles 

• View Pipes in the Profile View 

CHAPTER SETUP 

Run the Chapter 12 - 22049555201.exe file and restore all files to the C:\Civil 3D 20XX Projects folder. 

Do not change the location in which the Practice Files are installed. Doing so can cause errors when completing 

the exercises in this training manual. 

Exercise 11.1 View Pipes in the Profile  

➢ Edit the Pipe Style 

 Start Civil 3D by double clicking the  shortcut from your desktop. 

 Click the Application menu then hover over Open and select Drawing. 
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 Browse to the C:\Civil 3D 20XX Projects\22049555201\Drainage folder and select the 

DRPRRD07.dwg.  Click the Open button. 

 

 Edit the pipe display style for HGL and EGL. In Toolspace, on the Settings tab, expand the Pipe 

collection, then expand the Pipe Styles collection. 
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 Double-click the style FDOT Drainage to edit it. 

 

 Select the Display tab in the Pipe Style dialog box. 

 

 Select Profile in the View Direction drop-down. 
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 For the Hydraulic Grade Line and Energy Grade Line components, turn On Visibility, and set other 

display characteristics, such as color and layer, as shown.  Click the Apply and OK buttons. 

  

➢ View Pipes 

 Zoom to the S-1 Profile View.  Notice the blue line inside the pipe walls represents the hydraulic grade 

line, the red dashed line represents the energy grade line. 

 

Note You may wish to fade the grid lines in the profile view. To do this set the layer transparency to 70 for the 
layers GridMaj_dp and GridMin_dp. 

 

 Save the file and Close Civil 3D 


